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APPENDIX Z: PLAYER RESOURCES 

 

Z.1 Designer’s Notes 
The genesis of the Unity Rulebook was a set of 
informal guidelines I started developing early in 2016 
to allow cross-platform battles between players who 
had shifted to the Nova edition of the rules, and those 
who had elected to stick with the Admiralty Edition. As 
I delved deeper into the mechanics of such a battle, it 
became clear that, despite significant cosmetic 
differences between the two, the “heart” of the game 
had remained surprisingly consistent. A number of 
years had passed since the release of Nova, and 
there were several choices made in that edition which 
seemed like good ideas at the time, but in retrospect 
appear less so. 

Once the decision was made to begin a new edition, 
and in reviewing the long history of Starmada, I found 
myself looking more closely at concepts which had for 
one reason or another been jettisoned. As just one 
example, a change I had often regretted was the 
move away from “one damage die, one result” 
concept which had defined the Compendium era of 
the game. Although I still believe the benefits of the 
Starmada X damage resolution system outweighed 
the drawbacks, it still never felt “right”. To some 
degree I regained what I had been seeking with 
Admiralty, but even then there was still the need to 
account for the possibility of two types of damage 
result on a single die roll. 

Of course, Nova did away with the damage roll 
entirely—which was perhaps the only true mistake I 
made in that edition. The other changes I could justify 
for one reason or another; eliminating the damage roll 
was a “why not?” decision, when I should have been 
asking “why?” 

The Unity Rulebook reaches all the way back to the 
Compendium for damage resolution, in essence 
returning to Starmada’s roots: a 50/50 split between 
hull and systems damage, while retaining Admiralty’s 
proportional degradation as a way of ensuring no 
starship design will unfairly lose its fighting capability 
sooner than others. Variance in that area should be 
left to the whims of combat, not dictated by the 
construction process. 

Speaking of the construction process, one of the 
things brought back from Starmada X will be of 
interest mainly to math nerds: hull space is now a 
polynomial equation, rather than an exponential one. 
Likewise, the exponents have been removed from the 
engine factor and shield factor calculations. 

Over time, the construction process had gotten to the 
point where it was all but impossible to complete 
without automation. The online Starmada Drydock 
helped, as did player-designed spreadsheets, but I 
still feel it should be possible to design a starship from 
scratch with a pad of paper, a pencil, and a (non-
scientific) calculator without losing one’s mind. I’m not 
entirely sure that goal was achieved, but it is closer 
than it was—and every little bit helps. 

Starship construction is also an area in which Nova 
made a healthy contribution to the Unity Rulebook. 
The cost of non-shield defensive systems remains 
relative to a ship’s shield factor, rather than priced as 
a flat percentage of the ship’s available space (as in 
Admiralty). It’s a small change, and one hidden from 
players once the dice start rolling, but I believe it 
makes a big difference in the choices facing ship 
designers. Another holdover from Nova is the 
existence of ablative defenses; i.e. “Screens” (called 
“Armor” in the previous edition). This is something 
players had been clamoring for since the early days of 
Starmada, and it wasn’t until relatively recently I was 
able to bring it into the game. Now, with the Unity 
Rulebook, players can not only simulate “hit ’em until 
they’re gone” shields and/or armor plating, they can 
assign different strengths in four separate directions. 

These defensive arcs are something out of which I 
believe players will get a lot of use. They provide new 
opportunities for tactical thinking in a game that, if I’m 
honest, hasn’t always gone out of its way to 
emphasize such things. In addition to encouraging 
players to keep weakened side away from the enemy, 
the fact that defensive arcs cover 90°, while weapon 
arcs are expressed as multiples of 60°, means it will 
not always be possible to have the preferred 
defensive arc facing the enemy while also covering 
your intended target(s) with the main weapons 
battery. 

Decisions, decisions. 

Of course, those who don’t want to bother with such 
things still have the ability to retain the omni-
directional defenses of earlier editions of the game, 
and be assured their fleet will be appropriately 
balanced against most any other. As always, the 
emphasis is on ensuring a fun game is had by all; 
which includes doing everything possible to eliminate 
the “munchkin” temptation whenever and wherever 
possible. 
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One area in which I admit there may be potential for 
abuse is in the new rules for seeking weapons. 
Introduced first in the Nova edition, seekers were a bit 
of a departure for Starmada, which has traditionally 
been exclusively about “direct-fire” weapons (i.e. 
weapons which fire and immediately resolve their 
attack). Nova’s seeking weapons were a bit of a 
hybrid; still basically direct-fire weapons, but with a 
delayed impact allowing for a certain degree of 
defensive activity. 

While the Admiralty Edition did have “Seekers” as a 
sub-category of fighter flights, and before that there 
were “Drones”, such things were more correctly 
fighter variants and not true seeking weapons, which 
can fire repeatedly, have limited arcs of engagement, 
and so on. So long as ships are built with a mixture of 
direct-fire and seeking weapons, there should be no 
balance issues. However, seeker-heavy (or even 
seeker-exclusive) fleets have not been fully tested. 

Any volunteers? 

Speaking of fighter variants, one thing Admiralty 
possessed, which I had initially intended to carry over 
to Nova but never got around to, was the concept of 
“fighter capacity”. With this, players set aside a certain 
portion of their starship design for carrier space, 
which could then be filled by a nearly infinite variety of 
custom-built fighter flights. In the Unity Rulebook, I’ve 
clamped down on this. There are a number of 
reasons behind that choice, but ultimately the 
deciding factor was that Starmada is a game of 
starship combat. Fighters are meant to enhance the 
game, not dominate it. Nevertheless, some choice is 
still accounted for by an initial group of five variant 
fighter flights, with the possibility of more to come. As 
always, if you have any thoughts or suggestions, let 
us know. 

One of the things I have struggled with since the very 
first editions of Starmada is how to account for 
damage to weapons; i.e. how best to distribute the 
loss of individual weapon mounts over the course of a 
starship’s time in combat. This was, of course, the 
primary motivation behind the change to the damage 
resolution system in Starmada X; it was also one of 
the deciding factors in the design of the Nova edition, 
in which weapons damage was applied at a high level 
of abstraction. The Admiralty Edition perhaps came 
closest to a satisfactory resolution; however, it 
required an additional die roll, which never sat well 
with me. Further, it took a choice away from players, 
which is never a great idea, even if it is necessary to 
achieve a particular goal. 

I believe the Unity Rulebook provides the best of all 
worlds: the loss of overall firepower is regulated via 
introduction of the “weapons track”; player choice is 
reintroduced by not tying each damage result to 
specific battery or batteries; and proportional loss is 
dictated by “loss limits”, preventing players from 
building damage sinks into their designs. 

This change happily provided a solution to another 
long-term problem: How to account for damage to 
non-primary systems? A number of methods have 
been tried over the years, none of which were 
particularly satisfying. By treating special equipment 
as just another battery of weapons, I believe we’ve 
achieved an elegant resolution that will keep the 
game moving and eliminate the need for “loss checks” 
or other clumsy intrusions. Retaining Nova’s 
differentiation between equipment, munitions, and 
traits further alleviates the damage sink problem. 

A minor, purely aesthetic corollary to this is the return 
(last seen in Starmada X) of damage boxes for 
individual weapons and equipment items. I have little 
to say about this other than I really like them. 

In terms of actual gameplay, there’s not much that is 
changing. The game turn is still divided into 
Movement, Fighter, and Combat Phases, concluding 
with an End Phase to perform whatever administrative 
tasks may be required. The Orders Phase is back, 
after having been eliminated in Nova, which made 
sequential movement and combat the standard, thus 
removing the need for written orders. I will spare you 
the various thought processes that went into that 
decision, and just say I brought it back because I liked 
it, and because I think players liked it too. There is 
nothing quite like the suspense of having committed 
to a course of action while being unsure whether your 
opponent is going to do quite what you expected. It’s 
a relatively minor reversion, but one that enhances 
the playing experience considerably. 

I could continue for another several pages discussing 
the various tweaks and modifications which came and 
went during the development process. However, I 
think I’ll stop here and let you get back to blowing 
each other up. If you do want to know more, or have a 
suggestion to make things even better, please join 
your fellow gamers at our discussion forum, or get in 
touch via our Facebook page. 

Just a couple of shout-outs before I sign off: 

 Ken Burnside (of Ad Astra Games) has been a 
major source of advice and support throughout the 
revision process. His boundless enthusiasm for 
blowing up spaceships is infectious; I might not 
have ever completed this project without it. 

 Noel Weer has been a great sounding board and 
an all-around good egg. Then again, I expected 
nothing less. You’ll see much more of Noel’s 
contributions once the Imperial Starmada 
Sourcebook is released. 

 Ken Rodeghero did yeoman’s work proofreading 
this book. I suspect he will never actually play the 
game, as doing so would require reading these 
pages yet again. 

Happy gaming! 

Daniel Kast 
Castle Rock, CO 

April 2017 
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Z.2 Starmada Drydock Instructions 
This section provides a guide to the use of the 
Starmada Drydock spreadsheet, and assumes you 
have access to (and a working knowledge of) 
Microsoft Excel 2010. The spreadsheet may or may 
not function as intended when using other versions of 
Excel, or a third-party alternative (such as Apache 
OpenOffice). 

Each of the tabs is protected by default (except 
“Tables”, which is hidden, but not protected; p.75). If 
you need to unprotect a tab to make any changes, 
click “Home → Cells → Format → Unprotect Sheet.” 
To protect the sheet again, click “Home → Cells → 
Format → Protect Sheet,” and click “OK” on the 
confirmation dialog box. 

The current version of the Starmada Drydock is v2.0 
(December 2019). 

Worksheets 
The tabs labeled “SHIP1” through “SHIP5”  are where 
the actual starship design process occurs. User-
defined values are placed in the yellow cells; the 
orange cells contain calculations made by the 
spreadsheet itself. Do not rename these tabs; doing 
so will prevent the “Display” tab (p.75) from 
functioning properly. 

Faction, Class, Type: May be defined by the player 
as desired. On the starship display sheet, this will be 
formatted as “[Faction] [CLASS]-class [Type].” 

ORAT, DRAT, CRAT: The starship’s offensive, 
defensive, and combat ratings, respectively. 

Hull Size: Restricted to values from 1 to 35. 

Engines: Restricted to values from 0 to 12. 

Shields: Restricted to values from 0 to 5. 

 Fwd, Port, Stbd, Aft: Used to indicate the 
presence of directional shielding 

A starship may not have both standard and 
directional shields; if this happens, the 
spreadsheet will only apply the standard shields. 
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Screens: Restricted to values from 0 to 50. 

 Fwd, Port, Stbd, Aft: Used to indicate the 
presence of directional screens. 

A starship may not have both standard and 
directional screens. If this happens, the 
spreadsheet will only apply the standard screens. 

Tech Levels: Restricted to values from -2 to +2. 

Space Units Used, Remain: These columns provide 
a running total of how many space units (SUs) have 
been used by each part of the starship, as well as the 
number of SUs remaining to be filled. If the “Remain” 
column turns red, this indicates more space units 
have been used than are available. 

Weapons: Up to twelve banks may be entered. The 
pull-down menu contains a list of all available weapon 
systems, taken from the “Weapons” tab (p.74). 

Banks are entered in the following format: “xARCy”, 
where “x” is the number of mounts (1-9); “ARC” is the 
firing arc designation; and “y” is the number of 
weapons in a multi-weapon mount. If either “x” or “y” 
is omitted, the default value is 1. 

For example, “3AB” indicates a bank of three single-
mounted weapons with the [AB] firing arc; “BCE2” 
indicates a bank of one dual-mounted weapon firing 
into the [BCE] arc. 

The values entered into these boxes are not 
automatically restricted. Instead, the spreadsheet will 
resolve invalid entries as follows: any “x” value 
greater than 9 will result in no weapons being added; 
unknown firing arc designations will convert to the 
closest designation found in the list on the “Tables” 
tab (p.75); any “y” value between 5 and 9 converts to 
4; and any “y” value of 10 or higher will resolve using 
only the last digit. 

The ORAT column indicates the total offensive rating 
(ORAT) of the weapon battery. 

Systems: Up to ten different starship systems may be 
entered. The pull-down menu contains all available 
systems, taken from the list found on the “Tables” tab 
(p.75). You should not enter the same equipment or 
trait on multiple lines; if you do, the duplicated 
systems will turn red. 

 Qty: Limited to a range from 1 to 30. If omitted, 
the default value is 1. The spreadsheet will only 
recognize values greater than 1 for munitions and 
those equipment/traits that explicitly allow for 
multiples. The N column (blue boxes) indicates the 
actual value applied by the spreadsheet. 

 ORAT: The amount this system adds to the 
starship’s ORAT. 

 DRAT×: The multiplicative factor this system 
applies to the starship’s DRAT. 

 DRAT+: The amount this system adds to the 
starship’s defensive rating (DRAT). 

Weapons 
This tab is used to record the capabilities of weapon 
systems, allowing you to avoid retyping the values for 
each new starship design. As with the worksheet tabs 
(p.73), user-defined values are entered into the 
yellow/light green cells. The tab has room for up to 24 
entries. 

 

Weapon: May be named by the player as desired, 
with the exception that the greater-than sign (>) is 
reserved to indicate a secondary mode. For example, 
the “Anti-Fighter” mode of the “Laser Cannon” 
weapon system would be written as: “Laser 
Cannon>Anti-Fighter”. The name of the weapon 
system (or mode) will be shown on the starship 
display sheet exactly as entered. 

If a secondary mode is entered without a 
corresponding primary mode, it cannot be selected on 
the worksheet tabs (p.73); if multiple secondary 
modes are entered for a single primary mode, only 
the first (ordinally) will appear on the worksheet tabs. 

Unless using customized range bands, values are 
entered only in the first row of each weapon stat 
block. For customized range bands, a separate set of 
stats is entered for each desired band. If the row turns 
red, this means there is a problem with the values 
entered. (A row that contains one or more values, but 
is not yet complete, will turn red.) 

RNG: Restricted to values from -18 to 24. Negative 
values indicate standard weapons and must be in 
multiples of three (i.e. -3, -6, -9, -12, -15, or -18). A 
positive value indicates a seeking weapon (restricted 
to values between 4 and 12) or customized range 
bands. 

For customized range bands, each RNG value must 
be greater than the one preceding it. 

ROF, IMP, DMG: Restricted to values from 1 to 5. 

ACC: Must be 2, 3, 4, 5, or 6. The “+” is added 
automatically by the spreadsheet; do not type it 
manually. 

When entering customized range bands, two 
successive bands may not have identical 
ROF/ACC/IMP/DMG values. 

Traits: Up to five traits may be entered for each 
weapon system (or mode). The pull-down menu 
contains abbreviations for all available traits, taken 
from the list found on the “Tables” tab (p.75). If this 
column turn red, this indicates a problem with the 
traits as entered. 

Players must enter “Skr” to indicate a seeking 
weapon, although this trait will not appear on the 
starship display sheet. 

BSUR: The base space unit requirement of the 
weapon system (or mode). If this value is zero, it 
means the weapon is invalid in some way, and will not 
appear in pull-down menus on the worksheet tabs 
(p.73). 
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RNG: The maximum range of the weapon, used for 
ORAT calculations. 

Display 
This tab produces a starship display sheet which 
mimics the format used in official Majestic Twelve 
Games publications. Fonts are not embedded in the 
worksheet, which means your system must have the 
Eras Bold ITC and Tw Cen MT Condensed Extra Bold 
fonts installed for it to display properly. These are 
included with many Microsoft products, and can also 
be downloaded from fonts.com. 

The specific starship design to be displayed is 
selected from the pull-down menu in cell AD1. To 
produce the final display, it is necessary to hide all of 
the unused rows. Click on the arrow located in cell S1 
and ensure the checkbox next to “0” is empty, while 
the checkbox next to “1” contains a checkmark. 

 

Once this has been done, only those rows required 
for the specific starship design will be displayed, and 
the sheet can be printed. 

To show all rows once again, click on the arrow in cell 
S1 and ensure the checkbox next to “(Select All)” 
contains a checkmark (not a black box). 

 

Drake 
This tab generates a text-only starship display, 
utilizing A.6: Drake Notation (p.29). The starship 
shown corresponds to the design selected in the 
“Display” tab (p.75). 

To produce the final display, it is necessary to hide all 
of the unused rows. Click on the arrow located in cell 
B1 and ensure the checkbox next to “0” is empty, 
while the checkbox next to “1” contains a checkmark. 

Once this has been done, only those rows required 
for the specific starship design will be displayed. You 
may then highlight all of the visible cells in column A 
and select “Home → Clipboard → Copy” to copy the 
display; from there, you can paste it into a text 
document. 

To show all rows once again, click on the arrow in cell 
B1 and ensure the checkbox next to “(Select All)” 
contains a checkmark (not a black box). 

Tables 
This tab is hidden by default, and contains all of the 
lookup tables referred to by the other tabs. To unhide, 
right-click on any of the visible tabs and select 
“Unhide…”. To hide it once again, right-click on the 
“Tables” tab and select “Hide”. 

The “Tables” tab is not protected by default. None of 
the cells in this tab are limited by data validation or 
other settings; care must be taken when making any 
alterations. 

If you do make changes to the tables, be sure that 
each is sorted in descending order once you have 
finished. For example, if you add a new firing arc 
designation, you must highlight columns F, G, and H, 
and then click “Data → Sort & Filter → Sort,” making 
sure the following options are set: 

 “My data has headers” is checked. 

 “Sort by” Firing Arc. 

 “Sort On” Values. 

 “Order” A to Z. 

 

Columns A and B indicate the valid tech levels and 
the space unit adjustment for each. 

Columns C, D, and E list the valid weapon accuracy 
(ACC) values and the base space unit requirement 
(BSUR) modifiers for each. “Mod1” is used for 
standard weapons; “Mod2” is used for 
seeking/defensive weapons and for customized range 
bands. 
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Column F contains all valid firing arc designations. 
Columns G and H have no effect on the starship 
design or combat rating; these are used by the 
spreadsheet when sorting firing arcs on the starship 
display sheet. 

Columns I and J list the valid sizes of multi-weapon 
mounts and the multiplier applied to the BSUR for 
each. 

Columns K and L list the abbreviations for all valid 
weapon traits and the BSUR modifier for each. 
Columns M, N, and O are used when analyzing 
combinations of range-based traits. 

Columns P and Q are used by the spreadsheet to 
determine the factor applied to the offensive rating 
(ORAT) of weapons with the Expendable trait. 

Columns R through X list the valid starship systems 
and associated values: 

 Type is either equipment (E), munitions (M), or 
trait (T). “E1” and “T1” indicate equipment and 
traits which allow for multiples. 

 Space is the number of SUs required by the 
system. 

 ORAT is the addition to the starship’s ORAT made 
by the system. 

 DRAT× is the multiplicative factor applied to the 
starship’s DRAT by the system. 

 DRAT+ is the addition to the starship’s defensive 
rating (DRAT) made by the system. 

 Tech is the specific Technology Level category 
which applies to the system. 

Each system is duplicated five times, differentiated by 
“%1” through “%5”. This is necessary to ensure the 
worksheet tabs (p.73) compute their specific space 
requirements and ORAT/DRAT values properly.  

Columns Y through AB are used to create the pull-
down system lists on the worksheet tabs. 

Column AC is used by the spreadsheet when creating 
the Drake notation starship display. 
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Z.3 Consolidated Tables 
This section collects all of the tables and charts from 
throughout the rules and presents them in one 
convenient place. It will be updated as 
corrections/additions are made to the Starmada 
rules. 

2.2 Assembling the Fleet (p.12) 
Battle Size Fleet Limit VP Target 

Very Small 400 240 
Small 700 420 
Medium 1000 600 
Large 1500 900 
Very Large 2000 1200 

3.1 Movement Orders (p.16) 
Code Maneuver Rule 

Standard Maneuvers 
# Move forward # hex(es) 3.1 
P Turn one hexside (60°) to port 

(left/counter-clockwise) 
3.1 

S Turn one hexside (60°) to starboard 
(right/clockwise) 

3.1 

U Turn three hexsides (180°/“u-turn”) 3.1 

Special Maneuvers 
L Sideslip one hex to the left  3.4 
R Sideslip one hex to the right  3.4 

… +# Pivot # hexside(s) clockwise  3.4 
… -# Pivot # hexside(s) counter-clockwise 3.4 

Starship Systems 
C/… Activate cloaking device B.5 
H/… Hyperdrive warmup B.10 

Movement Options 
E/… Emergency thrust D.1 
Z/… Evasive action  D.3 
@/… Roll  D.7 
T/… Towing D.9 

Terrain 
[#] Planetary orbit for # hex(es) G.5 
 Increase one altitude level G.6 
 Decrease one altitude level G.6 

3.2 Engine Requirements (p.15) 
Turns Engine Requirement 
None Difference between previous and 

current speeds 
One Greater of previous and current speeds 

Two or Three 
or U-Turn 

Sum of previous and current speeds 

4.1 Declaration of Targets, Firing Arcs (p.19) 

   

4.2 The To-Hit Roll (p.20) 
Condition +/- Rule 

Range Modifiers 
Short 
 Dfs weapon 
 Fcs weapon 
 Dfs+Fcs weapon 
 Gid weapon 

+1 
+2 
-1 
-2 
0 

4.2 
C.5 
C.5 
C.5 
C.5 

Medium 0 4.2 
Long 
 Dfs weapon 
 Fcs weapon 
 Dfs+Fcs weapon 
 Gid weapon 

-1 
-2 
+1 
+2 
0 

4.2 
C.5 
C.5 
C.5 
C.5 

Target Modifiers 
Tiny 
 Acr weapon 
 Inc or NPr weapon 

-1 
0 
-2 

4.2 
C.5 
C.5 

Anti-Fighter Batteries (attacked by 
seeking weapons) 

-1 B.1 
C.4 

Cloaked (if detected) -1 B.5 
Countermeasures -1/level B.6 
Adjacent to hex targeted by 
Prx weapon 

-1 C.5 

Fire Control Modifiers 
Fire Control +1/level* B.8 
Probe within 3 hexes of target +1 B.17 
Evasive Action (attacker or target) -1/-2/-3 D.3 
Directed Damage -1 E.2 

Line of Sight Modifiers 
Flares -1/flare B.9 
Explosion -1/hex E.3 
Fighter screen -1/-2/-3 F.3 
Asteroid field -1/hex G.1 
Cometary coma/tail -1/hex G.3 

*Only if negative modifiers also apply. 

4.4 The Damage Roll (p.21) 
Roll Result 
1-3 Hull Hit: Check off one box on the hull track of 

the target’s display sheet. 
4 Engine Hit: Check off one box on the engine 

track of the target’s display sheet. 
5 Weapon Hit: Check off one box on the weapons 

track of the target’s display sheet. 
6 Shield Hit: Check off one box on the shield track 

of the target’s display sheet. 
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Sequence of Play (p.14) 

This outline summarizes all potential actions to be conducted during the course of a game turn, and the order in which 
they should occur. See the relevant rule for details on each entry. 

1) Orders Phase 
a. If using random movement initiative, assemble 

and shuffle activation deck (D.8). 

b. If using sequential movement, alternate 
proceeding through steps (1d) through (2c) 
with one starship at a time; if one side has 
more than twice as many ships, that side 
moves multiple ships at a time; unless using 
random movement initiative (D.8). 

c. If not using sequential movement, conduct 
steps (1d) through (2c) simultaneously for all 
ships. 

d. Record movement orders (3.1); determine 
engine requirements (3.2); expend boosters 
(B.3). 

i. Record use of secondary weapon modes 
(C.2); record shield reinforcement (E.6). 

e. Reveal movement orders; confirm orders are 
valid (3.2). 

2) Movement Phase 
a. Remove cloaked starships from game board; 

return uncloaked and detected cloaked 
starships to game board (B.5). 

b. Make hyperdrive warmup rolls; remove 
starships entering hyperspace from game 
board (B.10). 

c. Move all starships on game board according to 
movement orders (3.3). 

i. Apply damage due to minefields (B.15) and 
asteroid fields (G.1); resolve explosions 
(E.3). 

ii. Float game board as necessary (D.4). 

iii. Resolve stacking (3.3). 

iv. Utilize overthrusters (B.16). 

3) Fighter Phase 
a. If using random fighter initiative, assemble and 

shuffle activation deck (F.7). 

b. Alternate activating one fighter flight at a time; 
if one side has more than twice as many 
flights, that side activates multiple flights at a 
time (5.2); unless using random fighter 
initiative (F.7). 

i. Selected LRF flight may attempt to enter 
hyperspace (F.6). 

ii. Move selected flight on game board (5.3); 
or place on combat space patrol (F.1). 

iii. Interrupt flight’s movement with opposing 
flight on combat space patrol (F.1). 

iv. Declare attack by selected flight against 
adjacent target (5.4); or declare dogfight 
(F.2); or declare screening (F.3); or recover 
flight (F.5). 

v. Resolve defensive fire from target 
starship’s tractor beams (B.24) and/or 
Defensive weapons (C.5). 

vi. Resolve declared attack and apply effects 
immediately (5.4); resolve explosions (E.3). 

4) Combat Phase 
a. If using random combat initiative, assemble 

and shuffle activation deck (E.5). 

b. Alternate making attacks with one starship at a 
time; if one side has more than twice as many 
ships, that side attacks with multiple ships at a 
time (4.0); unless using random combat 
initiative (E.5). 

i. Declare all targets, confirming range, firing 
arc, and line of sight restrictions (4.1); 
declare directed damage (E.2). 

ii. For each target of each weapon battery, 
resolve effects of stealth (B.22); make to-
hit roll (4.2). 

iii. For each hit scored, make impact roll (4.3). 

iv. For each point of impact inflicted, make 
damage roll (4.4). 

v. If using sequential combat (E.5), apply 
effects of weapons damage (4.5); resolve 
explosions (E.3). 

c. Resolve starship systems/options used at the 
same time as weapons fire: 

i. Launch flares (B.9); launch probes and/or 
fire probes as weapons (B.17). 

ii. Resolve marine boarding attempts (B.14); 
trigger shockwave (B.19); use tractor 
beams (B.24). 

iii. Place seeker flights (C.4). 

iv. Make target acquisition (TAG) attempts 
(E.7). 

5) End Phase 
a. Apply gravitational pull due to black holes 

(G.2). 

b. Apply effects of weapons damage (4.5); 
resolve explosions (E.3). 

c. Evaluate victory conditions (2.5). 

d. Resolve damage from emergency thrust (D.1); 
perform damage control (E.1). 

e. Reverse pivots (3.4); activate stutterdrives 
(B.23); declare towing (D.9). 

f. Remove face-up flare/probe/TAG markers; flip 
face-down flare/probe/TAG markers to face up 
(B.9/B.17/E.7). 

g. Deploy mines (B.15); launch shuttlecraft 
(B.20); launch fighter flights (F.5). 
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A.1 The Design, Weapons (p.25) 

ACC Factor Seeking/ 
Defensive* 

2+ 0.43 0.50 
3+ 0.35 0.40 
4+ 0.25 0.30 
5+ 0.15 0.20 
6+ 0.10 0.10 

 
Weapon Trait Modifier 

Accurate (Acr) ×1.3 
Ballistic (Bls) ×0.8 
Carronade (Crn) ×0.8 
Catastrophic (Cts) ×2.0 
Deadly (Dly) ×2.0 
Diffuse (Dfs) ×0.9 
Disruptive (Dsr) ×2.0 
Expendable (Exp) ×0.2 
Fire-Linked (FrL) ×1.0 
Focused (Fcs) ×1.3 
Guided (Gid) ×1.1 
Incapacitating (Inc) ×0.7 
Kinetic (Knt) ×3.0 
Modulating (Mdl) ×2.5 
Non-Piercing (NPr) ×0.7 
Piercing 1 (Pr1) 
Piercing 2 (Pr2) 

×1.5 
×2.0 

Proximity (Prx) ×2.0 
Repeating (Rpt) ×1.4 
Scatter (Sct) ×1.7 
Slow (Slw) ×0.6 
Telescopic (Tls) ×1.9 
Volatile (Vlt) ×3.5 

 
 Crn Dfs Fcs Gid Sct Tls 

Bls ×0.5 ×0.6 ×1.1 ×0.9 ×1.1 ×1.7 
Crn  ×0.9 ×0.7 ×0.8 ×1.8 ×1.2 
Dfs   ×1.4 n/a ×1.7 ×1.5 
Fcs    n/a ×1.8 ×1.8 
Gid     ×1.7 ×2.3 
Sct      n/a 

 
Weapon Mount Modifier 

Single ×1.0 
Double ×1.5 
Triple ×2.0 
Quad ×2.5 

A.2 The Combat Rating, The Offensive Rating 
(p.26) 

Hull Size Exp Factor 
1-2 ×2.00 
3-5 ×1.75 
6-9 ×1.50 

10-14 ×1.25 
15-20 ×1.00 
20-27 ×0.75 
28-35 ×0.50 

A.4 Technology Levels (p.27) 
Technology Level SU Modifier 

+2 50% 
+1 70% 
0 100% 
-1 140% 
-2 200% 

B.9 Flares (p.33) 
Roll Effect 

1 None. The flare was a “dud”. 
2-4 Place a flare marker face down in a random hex 

adjacent to the target hex. 
5-6 Place a flare marker face down in the target hex. 

B.14 Marines (p.34) 
Hull Size Max Marines 

1-3 Two 
4-8 Three 

9-15 Four 
16-24 Five 
25-35 Six 

B.14 Marines, Shipboard Combat (p.34) 
Roll Number of Hits 
1-2 None 
3-5 One 
6 Two 

B.17 Probes (p.35) 
Roll Effect 

1 None. The probe was a “dud”. 
2-4 Place a probe marker face down in a random 

hex adjacent to the target hex. 
5-6 Place a probe marker face down in the target 

hex. 

C.1 Alternate Firing Arcs (p.39) 
Firing Arc Abbr Standard 

Forward FF AB 
Aft AA EF 
Port PP HJ 
Starboard SS IK 
Forward Port FP AC 
Forward Starboard FS BD 
Aft Port AP CE 
Aft Starboard AS DF 
Forward Restricted FR G 
Aft Restricted AR L 
Port Restricted PR C 
Starboard Restricted SR D 
Forward Half FH GHI 
Aft Half AH JKL 
Port Half PH ACE 
Starboard Half SH BDF 
Forward Extended FX ABCD 
Aft Extended AX CDEF 
Turret Restricted TR GHIJK 
Turret TT ABCDEF 

 
Firing Arc Abbr 

Forward Fwd 
Port Port 
Starboard Stbd 
Aft Aft 

D.3 Evasive Action (p.44) 
Engine Rating To-Hit Penalty 

1-2 None 
3-5 -1 
6-9 -2 
10+ -3 
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A.5 Starship Systems Table (p.28) 
Starship System Type Space Units ORAT DRAT Tech 

Anti-Fighter Batteries Trait Shield Factor × 1 - ×1.2 Shields 
Auxiliary Services 
(Cargo/Hospital/Repair/ 
Science/Transport) 

Trait Capacity × 50 - - N/A 

Boosters Munitions Engine Factor 
× 0.25 

Note [1] - Engines 

Carrier Trait 50/Flight 250/Flight +10/Flight Fighter 
 Launch Tubes Trait +10/Flight +50/Flight - Fighter 
Cloaking Device Equipment Shield Factor × 3 - ×2.0 Shields 
Countermeasures Equipment Shield Factor × 2 - ×1.5 Shields 
Directional Shielding Trait Note [2] - Note [2] Shields 
Fire Control Equipment Note [3] Note [3] - Weapons 
Flares Munitions 5/Flare (Engine Rating+10) 

× 0.5/Flare 
- Weapons 

Hyperdrive Equipment Engine Factor × 1 - ×1.2 Engines 
Ionized Hull Trait Shield Factor × 2 - ×1.5 

Note [4] 
Shields 

Long Range Sensors Equipment Note [5] Note [5] - Weapons 
Marines Munitions 10/Squad (Engine Rating+5) 

× 2/Squad 
+1/Squad Weapons 

Mines Munitions 5/Mine 25/Mine +1/Mine Fighter 
Overthrusters Equipment Engine Factor × 1 - ×1.3 Engines 
Probes Munitions 5/Probe (Engine Rating+6) 

× 1/Probe 
- Fighter 

Screens Trait 30/Screen - Note [6] Shields 
 Directional Screens Trait 15/Screen - Note [7] Shields 
Shockwave Trait Shield Rating 

× 100 
[Note 8] 

Shield Rating ×  
(Engine Rating+3) × 33 

[Note 8] 

- Shields 

Shuttlecraft Munitions 10/Shuttle 50/Shuttle +2/Shuttle Fighter 
Solar Sails Trait - - - N/A 
Stealth Equipment Shield Factor × 1 - ×1.2 Shields 
Stutterdrive Equipment Engine Rating 

× Engine Factor 
× 0.5 

Note [9] - Engines 

Tractor Beam Equipment 3 (Engine Rating+1) × 3 - Weapons 

[1] Increase the engine rating by 0.25 per Booster when computing all ORATs. 

[2]  Use the equivalent shield rating, computed on p.24. 

[3] Increase the SU cost and ORAT of all weapon batteries by 30%. 

[4] The listed modifier applies only to hull points; not to Screens. 

[5] Increase the SU cost and ORAT of all weapon batteries by 50%. 

[6] Each Screen counts as 0.75 hull boxes when computing the DRAT. A starship may not have both standard and 
Directional Screens. 

[7] Each forward Directional Screen counts as 0.67 hull boxes when computing the DRAT; each port/starboard Directional 
Screen counts as 0.50 hull boxes; each aft Directional Screen counts as 0.33 hull boxes. A starship may not have both 
standard and Directional Screens. 

[8] If the starship also has Directional Shielding, use the equivalent shield rating, computed on p.24. 

[9] Increase the engine rating by 50% when computing all ORATs. 

E.1 Damage Control (p.48) 
Roll Result 
1-3 None: There is no effect. 
4 Engines Repaired: Restore one box on the 

starship’s engine track. 
5 Weapons Repaired: Restore one box on the 

starship’s weapons track, and regain the use of 
the appropriate number of weapons and/or 
equipment. 

6 Shields Repaired: Restore one box on the 
starship’s shield track. 

E.7 Target Acquisition (p.50) 
Hull Size Number of TAGs 

1-3 One 
4-8 Two 
9-15 Three 

16-24 Four 
25-35 Five 

F.3 Fighter Screens (p.51) 
Number of Fighters Penalty 

1-3 None 
4-9 -1 

10-15 -2 
16+ -3 

F.5 Launch & Recovery (p.52) 
Hull Size Launch Max Recovery Max 

1-3 One One 
4-8 Two One 

9-15 Three Two 
16-24 Four Two 
25-35 Five Three 
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D.5 Freeform Turns (p.45) 
Turns Engine Requirement 
None Difference between previous and current 

speeds 
One Difference between previous and current 

speeds, plus 1 
Two Difference between previous and current 

speeds, plus 3 
Three or U-

Turn 
Difference between previous and current 
speeds, plus 6 

G.2 Black Holes, Gravitational Pull (p.55) 
 Size of Black Hole 

Distance 1 2 3 4 5 
1 - - - - - 
2 X - - - - 
3 1 X - - - 
4 1 X X - - 
5 0 2 X X - 
6 0 1 X X X 
7 0 1 2 X X 
8 0 1 1 3 X 

9-10 0 0 1 2 3 
11-13 0 0 1 1 2 
14-17 0 0 0 1 1 
18-22 0 0 0 0 1 
23+ 0 0 0 0 0 

Appendix S: Scenarios (p.58) 
Roll Scenario 

11-12 S.1: Alone in the Dark 
13-14 S.2: Breakout 
15-16 S.3: The Chase 
21-22 S.4: Fleet Action 
23-24 S.5: Hide & Seek 
25-26 S.6: Hit & Run 
31-32 S.7: On Patrol 
33-34 S.8: The Shakedown Cruise 
35-36 S.9: Storms in Space 
41-42 S.10: Tin Can Dustup 
43-44 S.11: To the Rescue 
45-46 S.12: The Trap 
51-66 None. Play a standard scenario as described 

on p.12. 

S.8 The Shakedown Cruise (p.62) 
Roll Result 

1 The starship has maintenance issues which 
severely hamper its performance. Apply a -1 
modifier to all of its to-hit rolls. 

2 As above, plus immediately decrease the 
starship’s engine rating by 1. 

3-4 The starship performs as expected; no special 
rules apply. 

5 The starship is much more effective than 
anticipated. Apply a +1 modifier to all of its to-hit 
rolls. 

6 As above, plus immediately increase the 
starship’s engine rating by 1. 

S.9 Storms in Space (p.63) 
Roll Result 

1 Each starship’s heading is changed to a random 
direction. (To determine a random direction, roll 
one die: 1 indicates the direction of the ship’s 
current heading; 2-6 indicate the remaining 
hexsides in clockwise order.) 

2 No starships may turn during the upcoming 
Movement Phase. 

3-4 No effect. 
5 During the upcoming Combat Phase, all attacks 

suffer an additional -1 to-hit penalty. In addition, 
no attacks may be made at long range. 

6 No starships may attack during the upcoming 
Combat Phase. 

X.1 Admiralty Edition, Combat (p.68) 
Admiralty Trait Unity Trait 

Anti-Fighter Accurate (Acr) 
Area Effect Proximity (Prx) 
Carronade Carronade (Crn) 

Catastrophic Catastrophic (Cts) 
Continuing Damage Disruptive (Dsr) 

Crew-Killer Deadly (Dly) 
Double Damage No equivalent; 

use Admiralty rules 
Doubled Range Modifiers Diffuse (Dfs) 

Extra Hull Damage Kinetic (Knt) 
Fighter-Exclusive No equivalent; 

use Admiralty rules 
Fire-Linked Fire-Linked (FrL) 

Halves Shields No equivalent; 
use Admiralty rules 

Ignores Shields Modulating (Mdl) 
Increased Hits No equivalent; 

use Admiralty rules 
Increased Impact No equivalent; 

use Admiralty rules 
Inverted Range Modifiers Focused (Fcs) 
Inv Rng-Based DMG/ROF No equivalent; 

use Admiralty rules 
Inv Rng-Based IMP Telescopic (Tls) 

Minimum Range Ballistic (Bls) 
No Hull Damage Incapacitating (Inc) 

No Range Modifiers Guided (Gid) 
Non-Piercing Non-Piercing (NPr) 
Piercing [X] Piercing (Pr1/Pr2) 

Range-Based DMG/ROF No equivalent; 
use Admiralty rules 

Range-Based IMP Scatter (Sct) 
Repeating Repeating (Rpt) 
Slow-Firing Slow (Slw) 

Starship-Exclusive No equivalent; 
use Admiralty rules 

Variable DMG/IMP No equivalent; 
use Admiralty rules 

Variable ROF Volatile (Vlt) 

X.2 Nova Edition, Playing the Game (p.69) 
Shield Dice Icons Modifier 

 
 
 

+10% 

 +5% 
 None 
 -5% 

X.2 Nova Edition, Combat (p.69) 
Roll Result 
1-3 Hull Hit: Check off one hull box from the target’s 

display. 
4-5 System Hit: Check off one system box from the 

target’s display. 
6 No Effect: The hit has struck a bulkhead or other 

non-essential section of the target. 



   January 2020 – www.mj12games.com 
82 

Z.4 Rules Index 
Alternate Firing Arcs ................................................ 39 
Anti-Fighter Batteries ............................................... 30 
Asteroids .................................................................. 54 
Auxiliary Services .................................................... 30 

Backwards Compatibility .......................................... 68 
Black Holes .............................................................. 55 
Boosters .................................................................. 31 

Campaigns .............................................................. 65 
Carrier ...................................................................... 31 
Cloaking Device ....................................................... 31 
Combat Procedure................................................... 18 
Combat Rating ......................................................... 26 
Combat Space Patrol ............................................... 51 
Comets .................................................................... 55 
Consolidated Tables ................................................ 77 
Countermeasures .................................................... 32 

Damage Control....................................................... 48 
Damage Roll ............................................................ 21 
Defensive Arcs......................................................... 30 
Defensive Rating ..................................................... 26 
Directed Damage ..................................................... 48 
Directional Screens .................................................. 36 
Directional Shielding ................................................ 32 
Dogfights ................................................................. 51 
Drake Notation ......................................................... 29 
Dual-Mode Weapons ............................................... 39 

Emergency Thrust ................................................... 44 
Engine Factor .......................................................... 24 
Engine Hits .............................................................. 21 
Engine Requirement ................................................ 15 
Engine Track ........................................................... 10 
Equipment ............................................................... 30 
Etheric Drag ............................................................. 44 
Evasive Action ......................................................... 44 
Explosions ............................................................... 48 

Fighter Screens ....................................................... 51 
Fighter Variants ....................................................... 52 
Fighters .................................................................... 22 
Fire Control .............................................................. 32 
Firing Arcs ............................................................... 19 
Flares ....................................................................... 33 
Fleet Limit ................................................................ 12 
Floating Game Board ............................................... 45 
Freeform Turns ........................................................ 45 

Game Board .............................................................. 4 
Game Components .................................................... 4 
Game Turn Record .................................................. 11 
Glossary .................................................................... 5 
Graded Turns .......................................................... 46 

Hull Hits ................................................................... 21 
Hull Track .................................................................. 9 
Hyperdrive ............................................................... 33 

Ionized Hull .............................................................. 33 
Impact Roll ............................................................... 20 

Launch & Recovery ................................................. 52 
Launch Tubes .......................................................... 33 
Line of Sight ............................................................. 19 
Long Range Fighters ............................................... 53 
Long Range Sensors ............................................... 33 

Loss Limits ............................................................... 21 

Maneuvers ............................................................... 16 
Markers ...................................................................... 5 
Marines .................................................................... 34 
Mines ....................................................................... 34 
Minimum/Maximum Rolls ......................................... 20 
Models ....................................................................... 4 
Movement Orders .................................................... 15 
Multi-Weapon Mounts .............................................. 39 
Munitions ................................................................. 30 

Nebulae ................................................................... 56 

Offensive Rating ...................................................... 26 
Overthrusters ........................................................... 35 

Partial Victory Points ................................................ 49 
Pivots ....................................................................... 17 
Planets ..................................................................... 56 
Probes ..................................................................... 35 

Random Combat Initiative ........................................ 49 
Random Fighter Initiative ......................................... 53 
Random Movement Initiative ................................... 47 
Range ...................................................................... 18 
Rolls ......................................................................... 46 

Scenarios ................................................................. 58 
Screens .................................................................... 35 
Seeking Weapons .................................................... 40 
Sequence of Play ..................................................... 14 
Sequential Combat .................................................. 49 
Sequential Movement .............................................. 46 
Shield Factor ............................................................ 24 
Shield Hits ................................................................ 21 
Shield Reinforcement............................................... 50 
Shield Track ............................................................. 10 
Shockwave .............................................................. 36 
Shuttlecraft ............................................................... 37 
Sideslips .................................................................. 17 
Solar Sails ................................................................ 37 
Space Units ............................................................. 24 
Speed ...................................................................... 15 
Stacking ................................................................... 16 
Starmada Drydock ................................................... 73 
Starship Construction............................................... 24 
Starship Display Sheet............................................... 9 
Starship Systems ..................................................... 30 
Starship Systems Table ........................................... 28 
Stealth...................................................................... 37 
Stutterdrive .............................................................. 38 

Target Acquisition .................................................... 50 
Technology Levels ................................................... 27 
Three-Dimensional Play ........................................... 57 
To-Hit Roll ................................................................ 20 
Towing ..................................................................... 47 
Tractor Beam ........................................................... 38 
Traits, Starship ......................................................... 30 
Traits, Weapon ........................................................ 41 

Victory ...................................................................... 13 

Weapon Battery Display .......................................... 10 
Weapon Hits ............................................................ 21 
Weapons Track ........................................................ 10


